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This guide is based on the MLA Handbook, 9th ed., published in 2021 by the Modern Language Association. In academic 
writing, when you borrow the words, facts, creations or ideas of others, you must cite, or give credit to, those sources.  

    
     
 
 

Core Elements for an MLA Works Cited Citation:   
Aim to locate all 9 core elements. If an element is not provided, skip it. Use punctuation mark shown after each element. 
 

1. Author. Last name, first name, middle initial. For multiple authors or no author, see p. 2 of this guide.  

2. Title of Source. 
Italicize titles of standalone sources (books, websites, magazines, journals, newspapers, databases). Put 
title in quotation marks if source is part of a larger work (chapters, short stories, a web page, articles).  

3. Title of 
Container, 

When a source is “nested” in a larger whole, the larger whole is the “container.” A source may have two 
containers: an article found in a journal (container 1) that is housed in a database (container 2). In this 
case, add elements 1-9 to your citation for the smaller 1st container, followed by elements 3-9 for the 
larger 2nd container. If a source has even more containers, continue to add elements 3-9 to your citation 
to account for each additional container. A print book does not have a container—it is self-contained. 

4.  Contributor, Precede contributor’s name with “by.” Examples:  edited by, translated by, illustrated by, uploaded by 

5. Version, A specific version or edition of a source, e.g., unabridged or abridged version     6th ed.     expanded ed.  

6. Number, If source is part of a numbered sequence. Examples:  vol. 1, no. 4      vols. 1-2      season 2, episode 1 

7. Publisher, 

Organization responsible for creating the source. For university publishers, abbreviate University as U 
and Press as P. Examples: U of Missouri P     Harvard UP. Omit business abbreviations such as Corp., Co., 
Inc., and Ltd. in publishers’ names. Omit publisher for journals, magazines and newspapers, and for 
websites with titles that are essentially the same as the publisher’s name.   

8. Publication Date, 

Day-Month-Year style. Spell out May, June, & July; abbreviate September to Sept.; abbreviate all other 
months to three letters. Example:  12 Feb. 2023. If a publication is issued by season, the season is not 
capitalized. Example:  summer 2022. Date of Access (date you accessed the source) is optional (unless 
your instructor says otherwise), but include it as last element of citation if no publication date is given.  

9. Location.  
For print sources: 
   page numbers or 
   page range 
 
For online sources: 
   DOI, stable URL/ 
   permalink, or URL  
 

For print sources:   Example:  p.24   /   pp. 45-56   /   pp.131-48   
 
For Online sources: If available, use a DOI (digital object identifier), which is often provided in academic 
articles from electronic sources. If the DOI does not have https:// or http:// in front of the DOI, put  

https:// in front of the DOI. Example: https://doi:10.2147/IJGM.S323316. If there is no DOI 

provided, look for a stable URL/permalink. Example: https://www.jstor.org/stable/26923507. If no DOI 
or stable URL/permalink exists, use regular URL, copying it from your browser’s window. If using a 
database, you can use its Cite tool to retrieve a citation and then check it for proper format. For URLs 
(but not DOIs), you can omit http:// and https:// to save space. 

          

 

MCC-Blue River Library 

BASIC RULE: 
Always follow 

the 
requirements 

 of your 
instructor.  

Cite Your Sources in Two Places:  

 

This Guide includes: 

Citation Guide:  MLA 9th Edition 

1. Within your essay, where you put brief in-text citations to link readers to the longer citations on the Works Cited page.    

2. On the Works Cited page, the last page of your essay, where you list complete citations for the sources you used. 

 

 

Additional Help: 

 

https://style.mla.org/
https://owl.purdue.edu/
https://doi:10.2147/IJGM.S323316
https://www.jstor.org/stable/26923507
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    Citations should be double-spaced (examples below are not). All lines 

    of a citation after the first line are indented one tab (1/2 inch) from the left 

    margin--this is called a hanging indent. See p. 7 for help with hanging indents. 
 
  
 
 
 
 

 
I 

 

Type of Source Works Cited entry  

 
 

 

Entire Book 
 
 

 
Format:   Author(s). Title of Book. Edition, Publisher, Year. Database Name (if electronic), URL. 

 
Example (Print book):  Bennett, Britt. The Vanishing Half. Riverhead Books, 2020. 

 
Example (E-book):   Hulick, Kathryn. Cybersecurity Careers. ReferencePoint Press, 2019, EBSCOhost, 
                                         search-ebscohost-com.ezproxy.mcckc.edu/login.aspx?direct=true&db= 
                                               nlebk&AN=1849580&site=ehost-live. 

 
 

 
 
 
 

Part of a Book 

(essay, chapter, 

 poem, story, 

encyclopedia entry, 

dictionary entry, etc.) 

 

 

 

 

 
Format:   Author(s). “Title of Part.” Title of Book, edited by Editor, edition, vol. #, Publisher, Year, 
                            page number(s). Database Name (if electronic), URL. 
 
Example (Essay     Lorenz, Janet. “Willa Cather.” Critical Survey of American Literature, edited by 

                                               Steven  Kellman, 3rd ed., vol. 1, Salem Press, 2016, pp. 475-82. EBSCOhost, 

                                              https://search-ebscohost-com.ezproxy.mcckc.edu/login.aspx?direct=true&db= 

                                              nlebk&AN=1442654&site=ehost-live.  

 

Example (Poem   Troupe, Quincy. “Poem for My Father.” Of Poetry and Protest: From Emmett Till 
                                             to Trayvon Martin, edited and compiled by Philip Cushway and Michael 
                                             Warr, W. W. Norton, 2016, pp. 194-95. 
 
Example (Print Dictionary):  “Ambit, N. (1).” Webster’s Ninth New Collegiate Dictionary, 9th ed., 
                                                                Merriam-Webster, 1998, p. 77. 
 
*Note: For dictionary words, include abbreviated part of speech (in italics) and number (in parentheses). 
 

 
 

Online Video 
 

(YouTube; TED) 
 
 

 
 

 
Format:   Author(s). “Title of Video.” Website Title, Website Publisher (if different than title), uploaded by 
                                              Name of User, Date of Upload, URL. 
 
Example:  “What’s New in the MLA 9th Edition Handbook.” YouTube, uploaded by Xamplio, 5 Oct. 2021, 
                                   https://www.youtube.com/watch?v=OflVWUwRRlI. 
 
Example:  Belle, Robert A. “Our Emotions and our Money.” TED, Jan. 2022, 
                                https://www.ted.com/talks/robert_a_belle_our_emotions_and_our_money.  
 

 1. Author.   

 2. Title of Source. 

 3. Title of Container. 

 4. Contributor, 

 5. Version, 

 6. Number, 

 7. Publisher, 

 8. Publication Date, 

 9. Location. 

Elements 

for an 

MLA 

Citation 

For 1 Author:    Morrison, Toni.  (Last Name, First Name.) 

For 2 Authors:  Kramer, Mark, and Wendy Call. (Last Name, First Name, and First Name, Last Name.)  

For 3 or More Authors:   Charon, Rita, et al. (Last Name, First Name of first author, et al.)  

For No Author:  Begin citation with title of source. 

 

 

 

 

 

 

 

 

 
 
 
 
 

How to Cite Authors’ Names 

in an e-book): 

in a print book): 

      MLA 9th Edition – Works Cited Citation Examples  

Details on p. 1 

If adding Annotated Bibliographies: Annotations are placed beneath the corresponding Works Cited citation 

and should be formatted as a block, tabbed one-half inch beyond the hanging indent, and double spaced.  
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Journal Article 

 from a 

Library Database 

 

Format:  Author(s). “Title of Article.” Title of Journal, vol. #,  no. #, Date of Publication, page number(s). 

                             Database Name, DOI, permalink/stable URL or URL. 

 

Example 1:  Virtanen, Marianna, and Marko Elovainio. “Justice at the Workplace: A Review.” Cambridge 

                           Quarterly of Healthcare Ethics, vol. 27, no. 2, Apr. 2018, pp. 306-15. ProQuest, 

                           https://dx.doi.org/10.1017/S0963180117000639. 

 
Example 2:  Mariti, Chiara, et al. “Owners as a Secure Base for Their Dogs.” Behaviour, vol. 150, no. 11, 
                             2013, pp. 1275–94. JSTOR, http://www.jstor.org/stable/23525230. 
 
Note:  For location element, a DOI/doi (if provided) is preferred. If DOI is not preceded with http:// or 
https://, precede it with https://. If a DOI is not given, use a permalink/stable URL or a regular URL. 

 
 
 

 

Magazine or 

Newspaper Article  

 (from print source, 

database & website) 

 

 

Format:     Author(s). “Title of Article.” Title of Magazine/Newspaper, vol. #, no. #, Date of Publication, 
                             page number(s). Database Name (if from a database), URL. 
 
Example:  Metcalfe, Elizabeth. “Restored and Revived.” House and Garden, Feb. 2022, pp. 86-93. 
 

Example:  Shuster, Simon. “Man In the Middle.” TIME Magazine, vol. 194, no. 26, Dec. 2019, 
                           pp. 42–47. EBSCOhost, https://search-ebscohost- 
                          com.ezproxy.mcckc.edu/login.aspx?direct=true&db=afh&AN=140105384&site=ehost-live. 
 
Example:  Spoerre, Anna. “Kansas City Zoo: Gorilla Tests Positive for Covid as Zoo Officials Await  
                              Vaccines.” The Kansas City Star, 6 Oct. 2021, 
                              https://www.kansascity.com/news/local/article254797357.html.    

 
 
 

Article 

 or Page  

 on a 

 Website 

 

 

Format:   Author(s). “Title of Article or Web Page/Section.” Title of Overall Website, Website Publisher (if 
                              different than website title), Date Published, URL. 
 
Example:   Mayo Clinic Staff. “Food Allergy.” Mayo Clinic, Mayo Foundation for Medical Education and 
                               Research, 31 Dec. 2021, https://www.mayoclinic.org/diseases-conditions/food- 
                               allergy/diagnosis-treatment/drc-20355101.  
 
Example:    “Hearing Loss: An Overview.” American Hearing Research Foundation, 2022, 
                               https://www.american-hearing.org/disease/hearing-loss-an-overview/. Accessed 31 
                               Mar. 2022. 
 
Note: If no author is provided, start citation with title of source. If no exact publication date provided, 
include date you accessed the source as last element of citation.  

 

Article or Page 

 on a Government 

Website 

(Government agency 

as author & publisher) 

Format:       Author(s). “Title of Article or Page.” Title of Overall Website, Website Publisher (if different 
                             than website title), Date of Publication, URL. 
 
Example:     United States, Environmental Protection Agency. “Unconventional Oil and Natural Gas 
                               Development.” United States Environmental Protection Agency, 12 Oct. 2021, 
                               https://www.epa.gov/uog. 
 
Note: If website’s name is essentially the same as name of publisher, you can omit publisher’s name. 
 

 

Artwork 

 Viewed 

 Online 

 

Format:     Artist(s). Image Title. Date of creation. Title of Overall Website, Website Publisher (if different 
                            than website title), URL. 
 
Example:  Kelly, Ellsworth. Wild Grape. 1960. MoMA, https://www.moma.org/collection/works/88128. 
 
Note: If image is untitled, give a concise, informative description of it (no italics or quotation marks).                  

 2 authors 
 & has DOI 

 3 or more 
 authors & has 
 permalink/ 
 stable URL 

(print magazine) 

0 

0 

(library 
database) 

0 

0 
(newspaper
website) 
0 

0 

 (No author or 
 exact date of 
 publication.) 

       Type of Source          Works Cited entry 

 MLA 9th edition – Works Cited Examples (continued)  

 

 

https://dx.doi.org/10.1017/S0963180117000639
http://www.jstor.org/stable/23525230
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In-text citations provide a means to give credit within the text of your paper when you are borrowing others’ words, facts, 

creations, or ideas. Use in-text citations when:  quoting -- enclosing someone’s exact words within quotation marks 

                                                                   paraphrasing -- putting the ideas of others into your own words and sentences 

                                                              or summarizing – using your own words to give an overview of another’s main points  

MLA In-Text Citation Basics:  

• MLA in-text citations generally contain the author’s last name and the source’s page number. These brief 
citations identify your sources in the text of your paper at points where you are borrowing material, usually at the 
end of a sentence. In-text citations refer readers to the Works Cited list, where complete citations are listed.  
 
Examples:   If you mention the author’s name in a sentence, you need only include the page number in 
                     parentheses:  Cain concludes that “Love is essential; gregariousness is optional” (264). 
 
                    
                     If you don’t mention the author’s name in a sentence, you put the author’s last name and the 
                    page number in parentheses:  A record of our times evolves through everyday news stories (Cioffi 11). 
    
 

• If no author is provided, use a shortened version of the title of the source within parentheses or, alternatively, 
the complete title of the source within the text of your paper. The first word of the shortened title must be the 
same as the first main word (not A, An, or The) of the source’s complete title on the Works Cited page. For 
shortened titles, use the first word or words of the complete title, ignoring the words A, An, The. 
 
If page numbers are not provided, which is common for internet sources, do not include them. PDF articles may 
have page numbers, so use them if available.  

  
 
Sample In-Text Citations for the Works Cited citation example below: 
 
               Linford, Jenny. The Seven Culinary Wonders of the World: A History  

            of Honey, Salt, Chile, Pork, Rice, Cacao, and Tomato. Illustrated  

            by Alice Pattullo, Smithsonian Books, 2018. 

 

 

Paraphrase, 
Author in 

parentheses 

       
      Until the mid-19th century, chocolate was enjoyed only in liquid form 
      (Linford 174). 

Quote, 
Author in 
sentence 

     Of research on honey’s use in medicine, Linford writes, “Recent 
     findings show that raw honey can kill more than 250 clinical strains of 
     bacteria, including the so-called superbug MRSA” (62). 

Author in 
sentence 

       
      As Jenny Linford notes, “[O]nly 6 percent of the salt produced in the 
      world today is used for food purposes” (79). 

Note: The closing period goes after the parentheses. 

Quote, 

 A paraphrase of Cioffi’s words 

 An exact quote from Cain, within quotation marks 

Signal phrases “signal” 

that borrowed 

information is coming.  

Sample 

In-text 

Citations

s 

In-Text Citations: Information & Examples 
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  In-Text Citation Examples:  continued 

      Paraphrase,                        
        No author 

Fathers participating in a weekly program of reading to their children said 
that the activity improved their parenting skills (“Engaging Fathers” 27).  

   Quote divided by 
     your own words  

“He was obeyed,” writes Joseph Conrad of the company manager in Heart 
of Darkness, “yet he inspired neither love nor fear, nor even respect” (87).  

     Paraphrase, 
    two authors 

Others note that doctors have not yet adequately explained the effects 
climate change will have on human health (Lemery and Auerbach 4-5).   

  Quote divided by 
   your own words  
   (indirect source)  

With her art, Carrie Mae Weems addresses social change and what she 
refers to as “the ism brothers” – racism, sexism and classism 
 

 In-text Citations for Indirect Sources – An Example 

A source that paraphrases or quotes another source is called an indirect source. Example: an article by Linda S. Watts 
includes a quote by Carrie Mae Weems, and you want to use the Weems quote in your paper. When possible, find the 
original source of the quote and not a secondhand source. But if the original source can’t be located, cite the source 
that you are looking at (in this case, the article by Watts). 
 
        To cite Weems within the text of your paper: 

1. Name the original source of the information—in this case, Weems—in the text of your paper immediately before 

 you quote or paraphrase the source.  
2. Cite the indirect source, Watts, in the parenthetical citation following Weems’ words:  (qtd. in Watts 55-56). 

Be sure to cite Watts in the Works Cited list at the end of your paper (but not Weems). 

Block Quotes (for Long Quotations)           

If a quote runs more than four lines of your text (or more than three lines for verse/poetry):  Block quote off from the 

rest of the text by indenting the entire quote a one-half inch (one tab) from the left margin. The introductory phrase you 

place before your long quotation usually ends with a colon. Do not enclose the block quote in quotation marks.  

Block Quote Example: 

Nick describes his impression of Gatsby at their first meeting: 

 He smiled understandingly—much more than understandingly. It was one of 

 those rare smiles with a quality of eternal reassurance in it, that you may come 

 across four or five times in life. It faced—or seemed to face—the whole external 

 world for an instant, then concentrated on you with an irresistible prejudice in 

 your favor. (Fitzgerald 48) 

  For block quotes, the closing period goes before the parentheses. 

Phrase 
introducing 

 quote 

 Title of source (shortened) 

Block 

quote,      

indented 

1/2 inch 

 from left 

margin 

Page 
number 

Page 
 number 

Author and page number 

(qtd. in Watts 55-56). 

Two       
Authors 
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                                                      Formatting Your MLA Paper                     

 

 

1.  Click on “Layout” tab. Click Margins. Click on box that says “Normal.” This is the default setting (1 inch on all sides). 

2.  Click on “Home” tab at far left of tool bar, select Times New Roman from the font box and change font size to 12. 

3.  While you’re still on the “Home” tab, click the 3 dots at the far right end of the toolbar and click “Line Spacing.”  

     In the Line Spacing box at left, click the number 2 for double spacing. 

4.  Click on the 3 dots again > click Line Spacing, then move to the “Line Spacing” box at left and click “Remove Space 

     After Paragraph” at bottom of box. This will make sure that you aren’t adding additional spaces after each paragraph!  

 5.  Where cursor is blinking at top left of your paper, type the 

      following, each on a separate line: 

        Your First and Last Name          Example:   Xander Smith 

        Your instructor’s name              Example:   Professor Cohen 

        Name of your course                  Example:   English 101 

        Today’s date                                 Example:   12 May 2023 

 

6. To set up your header with your last name and page numbers, click on the little tab sticking out at the top right side 

    of your document. A three-column header box will open above. Click inside the column farthest to the right and type 

   your last name (but no numbers or spaces). 

 

7. Next, select (highlight) your last name (within the header) and change font on Header to Times New Roman, size 12.  

8. Click on the “Insert” tab towards top left of your screen, then click Page Numbers in right middle area of tool bar. 

9. See the six boxes and click on the box in the top right. 

10. You should see the symbol  < # > beside your name at the top right of your page.  Example: Smith < # > 

11. Double-click on your document outside of your header. Notice that header will not display on your screen, but it 

       is still there. To see it, click on File > Print > Print this Document, which takes you to Print Preview to see your 

       header. But don’t print the document if you’re not ready. You can just click Cancel to get out of Print Preview.  

12. To center and type your paper’s title, hit Enter on keyboard to move down to a new line. Click “Home” tab, then 

      click “Text Alignment” icon              above middle of your document. Select Align Center, then type the paper’s title. 

13. Hit Enter on keyboard to move down to a new line. Click the “Text Alignment” icon           again, and this time choose 

      Align Left.                    

14. Hit “Tab” on keyboard to indent and start typing your paper. Be sure to hit the Tab key every time you start a new 

       paragraph, unless Word Office 365 does it automatically for you.  

Type last name here 

For Microsoft Word 365 (online version) 

  Note:  Even though you set up your font 

  at the beginning, make sure all text is 

 showing up as Times New Roman font, 

 size 12, in your header and in your paper. 

 If it isn’t, click cursor in front of text, 

 select the text, and repeat step 2 above.  

See p. 7 for 
 Works Cited page 

 formatting  
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Formatting Your MLA Paper  

 

                                                                                                                                                             (See p. 8 for Sample MLA Paper)    

 

 

1.  Click on “Layout” tab. Click Margins. Click on box that says “Normal.” This is the default setting (1 inch on all sides). 
2.  Click on “Home” tab at far left of tool bar, select Times New Roman from the font box and change font size to 12. 
3. In “Paragraph” section on left side of tool bar, click on the tiny arrow in lower right.  Paragraph box appears; in 
   “Line Spacing” dropdown box, select Double. Also, check the box next to “Don’t Add Space to Paragraphs of the 
    Same Style” to make sure that you aren’t adding additional spaces after each paragraph! 

4.  Where cursor is blinking at top left of your paper, type the following, each on a separate line: 
         
      Your First and Last Name          Example:   Xander Smith 
      Your instructor’s name              Example:   Professor Cohen 
      Name of your course                  Example:   English 101 
      Today’s date                                 Example:   12 May 2023 
 
5.  To set up header with last name and page numbers: 
     On first page of your paper, click “Insert” tab at top left, then “Page Number” at right. Click top of page option, then 
     Plain number 3 box.  
6.  Click once at immediate left of the number 1, then type your last name and hit the space bar once.  Ex.:  Smith 1 

7. Select (highlight) last name and page number. Click on “Home” tab and change font to Times New Roman, 
    size 12. To close header, double click below the dashed line. 
8.  To center and type your paper’s title, hit Enter on keyboard to move down to a new line. Click “Home” tab, then 
     click Center button in Paragraph section. Type the title of your paper. 
9. Hit Enter on keyboard to move down to a new line. Click Align Left button in Paragraph section. 
10. Hit “Tab” on keyboard to indent, then start typing your paper. Hit Tab key every time you start a new paragraph. 

 

 

1. Change font from Arial to Times New Roman and font size from 11 to 12. 
2. To change line spacing to double space:  > Format > Line & Paragraph Spacing > Double 
3. Click Insert > go to Header & Footers > click on Header. 
4. Make sure font on Header is Times New Roman, size 12. 
5. Click Align icon above your paper; select Right Align to move cursor to right side of page. Hit Enter. 
6. Type your last name, then press spacebar on keyboard once.  Example:  Smith 1  
7. Click on Insert > Page Numbers. See four squares; click on top left square. 
8. Click below Header line to close Header. 
9. Where cursor is blinking at left, do step 4 in the Regular Microsoft Word instructions above. Next, click enter to go down a line. 
10. Click Align icon above your paper; select Center Align and type title of your paper. Hit enter to move down to a new line. 
11. Click Align icon again; select Left Align. Hit Tab on keyboard to indent, then start typing your paper.  
12. Remember to hit the Tab key every time you start a new paragraph. 

 

 
 Works Cited Page and Hanging Indents   Create the Works Cited list on its own page, right after your essay. 

 Click Align Center icon, type the words Works Cited (no bold, no italics, no quotation marks) and hit Enter once. Click Align Left icon. 
Type citations, listing them alphabetically by author’s last name (or by title of source if no author is given). Indent second and 
subsequent lines of each citation one-half inch (0.5”) from the left margin—this is called a hanging indent. To create hanging indents:  
Highlight your Works Cited citations all together, making sure there is double spacing between each line. 
Then, For Word and Word 365:   
Right click and select Paragraph (or “Paragraph Options” in Word 365). Under Indentation – Special, select hanging  >  OK. 
(In Word 365 use drop-down menu to select “hanging.”) For Google Docs:  Follow above instructions, but after “Right click,” select 
Format in tool bar, go down to Align & Indent  >  Indentation Options  >  Special Indent  >  Hanging  >  OK. See p. 8 for examples.  

                                    

 

For Regular Microsoft Word (traditional version) 

Note:  Even though you set up your font at the 

beginning, make sure all text is showing up as 

Times New Roman font, size 12, in your header and 

in your paper. If it isn’t, click cursor in front of text, 

select the text, and repeat step 2 on p. 6. 

For Google Docs 
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Student’s First and Last Name 

Instructor’s Name  

English 101 

12 May 2023 

We Should Read Online Reviews with a Critical Eye  

Most of us in America – 93 percent – use online reviews when making a new purchase, and we 

 generally find them helpful (Turner and Rainie). Yet we have reasons to be wary, with reports of third-

party “marketers” paying people for positive reviews (Botsman 146-47), and a recent announcement by 

Tripadvisor that it removed 1.3 million fake reviews in 2022 (sec. 03). Although online reviews are often 

beneficial, the risks of deception abound. As tech columnist John Thornhill notes, “[T]echnology is 

transforming trust-based transactions, but it also has created new problems of its own.” Unfortunately… 

 

 ----------------------Pretend this is the Works Cited page (a separate page after your essay)--------------  

                                                                                                                                                                                                            

 

 

Botsman, Rachel. Who Can You Trust?: How Technology Brought Us Together and Why It Might Drive 

          Us Apart. Public Affairs / Hachette Book Group, 2017.

Thornhill, John. “Online Reviews are Testing Tech’s Trust Revolution.” Financial Times, 14 Sept. 2020, 

           http://ezproxy.mcckc.edu/login?url=https://www.proquest.com/trade-journals/online-reviews-are- 

           testing-tech-s-trust/docview/2467902139/se-2?accountid=2182. 

“Tripadvisor Review Transparency Report 2023.” Tripadvisor,12 Apr. 2023, sec.03,  

           https://www.tripadvisor.com/TransparencyReport2023. 

Turner, Erica, and Lee Rainie. “Most Americans Rely on Their Own Research to Make Big Decisions, 

          and That Often Means Online Searches.” Pew Research Center, 5 Mar. 2020,  

 A Works Cited list is organized 

 alphabetically by author’s last 

 name. If a name is not available, 

 use the title of the source. 

 

1/2 

 inch 
hanging 
 indents 

 

 

Entire 
paper: 

Times 
New 

Roman 
12 pt. 

font 

Double-
spaced 

1-inch 
margins 
all sides 

Student’s Last Name 1 

        Need Help? 
 MCC-Blue River Library - 816-604-6642 
 https://mcckc.edu/library/blue-river 

 
       

MLA 9 Citation Guide update May 2023.docx  

  Title of Your Essay 

 Student’s Last Name 10 

  Works Cited 

 If no author is given, 

 use the title of the 

 source. Use shortened 

 title for in-text citation. 

ProQuest, 

Ask-a-Librarian: 
 https://mcckc.edu/library 

 Text:  816-920-0275 
          
 

https://pewrsr.ch/2VO7bQn. 

In-text 
citation 

with 
 author and 

 page 
numbers 

 

Sample MLA-style Paper 

(Abbreviated) 

In-text 

citation with 

author in 

sentence, no 

page number 

available. 

http://ezproxy.mcckc.edu/login?url=https://www.proquest.com/trade-journals/online-reviews-are-%0b%20%20%20%20%20%20%20%20%20%20testing-tech-s-trust/docview/2467902139/se-2?accountid=2182
http://ezproxy.mcckc.edu/login?url=https://www.proquest.com/trade-journals/online-reviews-are-%0b%20%20%20%20%20%20%20%20%20%20testing-tech-s-trust/docview/2467902139/se-2?accountid=2182
https://www.tripadvisor.com/TransparencyReport2023
https://mcckc.edu/library/blue-river
https://mcckc.edu/library

